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Introduction

Welcome to Nik Software Sharpener Pro 3.0, the most advanced and 
powerful sharpening solution for photographers. Sharpener Pro 3.0 
eliminates the guesswork typically required for achieving superior 
printed results while providing the most control possible.

Based on continuous feedback from professionals in  
Nik Software’s photographer community, Sharpener Pro 3.0 is 
a suite of proven controls to help photographers save time, get 
repeatable, professional results and de-complicate the mystery  
of sharpening images.

Sharpener Pro 3.0 is a new generation of digital sharpening tools  
for photographers, featuring on-image editing with U Point® 
powered control points, creative sharpening tools, as well as the 
most advanced algorithms designed specifically for sharpening 
digital photographs.

What’s in the User Guide

In addition to providing installation instructions, the User Guide 
shows you how to choose, control, and selectively apply filters, both 
with U Point powered control points and the updated Selective Tool. 
The User Guide also points out differences between Sharpener Pro 
3.0 and Nik Sharpener Pro 2.0.

The typographical conventions used in this manual are:

•	Sharpener	Pro	3.0	processes	and	user	interface	components	
appear in Initial Caps, with first instances in Bold Caps.  
(In context-appropriate cases, later instances also appear  
in Bold Caps.)

•	Specific	control	inputs	appear	in	Bold Italic. Control inputs 
can be menu items, buttons, or sliders. Where first instances 
coincide with specific control inputs, the term appears in  
Bold Italic.

Chapter 1: Introduction

© 2008 David Saffir
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New Creative Sharpening Features
The new creative sharpening features offer photographers the 
ultimate solution to enhance fine details and textures, drawing 
attention to desired areas within the image. (Please see Creative 
Sharpening in Chapter 9.)

Selective Tool Interaction
Originally, the Selective Tool was used to specify when to apply a 
Sharpener Pro 2.0 filter selectively to an image. As the popularity of 
Sharpener Pro 2.0 grew, photographers discovered that the Selective 
Tool offered more convenient access to filters than the Filters menu.

Sharpener Pro 3.0 makes this access more convenient by giving you 
the choice of selectively applying the filter in the Filter Interface. 
This lets you launch the Sharpener Pro 3.0 interface from either 
the Selective Tool or the Filters menu. (Please see Interaction with 
Sharpener Pro 3.0 in Chapter 10.)

Chapter 2: What’s New in 3.0

What’s New in 3.0
Sharpener Pro™ 3.0 offers many enhancements and improvements 
over Nik Sharpener Pro™ 2.0, in four general categories:

•	Interface

•	U	Point	powered	Control	Points

•	New	creative	sharpening	features

•	Selective	Tool	interaction

Interface
Sharpener Pro 2.0 users will notice the extensively reworked 
interface in version 3.0, the result of both deep study into the 
look and feel that professional photographers expect in modern 
applications and requests from Nik Software users.

The new, completely resizable interface is a professional 
photographic tool: color-neutral with a medium-gray background 
and a strong focus on efficient workflow. Sharpener Pro 3.0 groups 
major controls close together for greater efficiency, letting you 
achieve excellent results in less time. (Please see Chapter 7: 
Sharpener Pro 3.0 Interface.)

U Point Powered Control Points
U Point® technology lets photographers achieve exactly what they 
envision in an easy, fast, and intuitive manner. U Point-powered 
control points in Sharpener Pro 3.0 let you easily and selectively 
control where each filter is applied and to the images, without the 
use of complicated selections or layer masks. (Please see Control 
Points in Chapter 5.)



Chapter 3

Installation
Installing and Accessing Sharpener Pro™ 3.0
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Installation

Sharpener Pro 3.0 is a plug-in for Adobe® Photoshop®, Adobe 
Photoshop Lightroom®, Apple® Aperture™ and other Photoshop plug-
in compatible applications. The installer provided with Sharpener 
Pro 3.0 automatically attempts to locate a copy of Adobe Photoshop, 
Adobe Photoshop Lightroom or Apple Aperture.

Installing Sharpener Pro 3.0 and the Selective Tool

Before you install Sharpener Pro 3.0, please close all applications 
including Adobe Photoshop, Adobe Photoshop Lightroom, Apple 
Aperture or other image editing applications that will serve as host 
for Sharpener Pro 3.0. Please do not open any other applications 
during the installation process.

To begin installation: 

Double-click on the installation file provided either on your 
Sharpener Pro 3.0 CD or downloaded from the Nik Software web site. 
A window appears displaying the Sharpener Pro 3.0 Setup Wizard.

Double-click 
the Installer

The installer walks you through the procedure. 

After you have read the Read Me file and accepted the End User 
License Agreement, the installer prompts you for the plug-in location 
of your image editing application.

The installer attempts to locate the most recent installation of Adobe 
Photoshop or Adobe Photoshop Elements, and if successful, displays 
the recommended folder. When installing into Apple Aperture, the 
installer will automatically install into the appropriate location.

Sharpener 
Pro 3.0 
Setup

If the installer is unable to locate Adobe Photoshop or Adobe 
Photoshop Elements, or if you are using an image editor other  
than Adobe Photoshop, you must specify the appropriate  
installation path.

For Adobe Photoshop or Adobe Photoshop Elements, this location is 
the Plug-Ins folder located under the application’s main folder.

Chapter 3: Installation
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If you want the Selective Tool to open each time Adobe Photoshop 
or Adobe Photoshop Elements launches, leave the Open the Nik 
Selective Tool automatically box checked. The Selective Tool lets you 
apply Sharpener Pro 3.0 effects by automating the layer systems 
in Adobe Photoshop or Adobe Photoshop Elements. (Please see 
Chapter 10: Selective Tool.)

Uncheck this box to prevent the Selective Tool from opening each 
time Adobe Photoshop or Adobe Photoshop Elements launches. You 
can change this option within the Selective Tool settings interface. 
(Please see Chapter 12: Selective Tool Settings.)

Note: The Selective Tool is available only with Adobe Photoshop and 
Adobe Photoshop Elements serving as host for Sharpener Pro 3.0.

Click Finish to complete the installation process.

For example:

Adobe Photoshop

Windows – C:\Program Files\Adobe\Adobe Photoshop\Plug-Ins

Macintosh – Macintosh HD : Applications : Adobe Photoshop :  
Plug-Ins

Adobe Photoshop Elements

Windows – C:\Program Files\Adobe\Adobe Photoshop Elements\
Plug-Ins

Macintosh – Macintosh HD : Applications : Adobe Photoshop 
Elements : Plug-Ins

Click Browse… to open the Browse for Folder window, then navigate 
to the appropriate folder.

Note: For guidance on the location of Plug-Ins in applications 
other than Adobe Photoshop or Adobe Photoshop Elements, 
please refer to your application’s user manual.

After selecting the appropriate folder location, click Install. When 
the installation is complete, the final page of the installer appears.

If you want Sharpener Pro 3.0 to be automatically added to 
Lightroom’s list of External Editors, leave the Add as External Editor 
for Lightroom box checked. The Add as External Editor for Lightroom 
option is only available if Lightroom is detected during installation. 
Instructions are provided within this chapter to manually add 
Sharpener Pro 3.0 as an external editor for Lightroom. (Please see 
Adding Sharpener Pro 3.0 to Lightroom as an External Editor.)

Chapter 3: Installation
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Accessing Sharpener Pro 3.0 and the Selective Tool 
in Adobe Photoshop
After completing the installation, launch your image editing 
application. In Adobe Photoshop and Adobe Photoshop Elements, 
Sharpener Pro 3.0 is accessed from the Filter menu.

To begin using Sharpener Pro 3.0:

1. Open the image that you would like to enhance.

2. Click the Filter menu.

3. Roll over the Nik Software sub-menu. A popup menu appears.

4. Select one of the Sharpener Pro 3.0 filters from the popup. 

5. The choices are:

•	Sharpener Pro 3.0: (1) RAW Presharpener

•	Sharpener Pro 3.0: (2) Output Sharpener

The Sharpener Pro 3.0 interface appears, displaying the image 
specified in step 1 above. There are two filters within Sharpener Pro 
3.0, RAW Presharpener and Output Sharpener. To apply a filter to 
the image, select the filter from the Filter menu, or select the filter 
directly from the Selective Tool. (Please see Chapter 5: Sharpener 
Pro 3.0 Interface and Chapter 10: Selective Tool.)

You can access the Selective Tool by navigating to one of the 
following locations:

Adobe Photoshop

File > Automate

Adobe Photoshop Elements

File > Automation Tools

Chapter 3: Installation

Accessing Sharpener Pro 3.0 in Apple Aperture

In Apple Aperture, Sharpener Pro 3.0 is accessed from the Images 
menu. To begin using Sharpener Pro 3.0 in Apple Aperture:

1.  Highlight the image(s) that you wish to enhance with 
Sharpener Pro 3.0. 

2. Click the Images menu.

3. Roll over the Edit With sub-menu. A popup menu appears. 

4. Select one of the Sharpener Pro 3.0 filters from the popup. 

5. The choices are:

•	Sharpener Pro 3.0: (1) RAW Presharpener

•	Sharpener Pro 3.0: (2) Output Sharpener

The Sharpener Pro 3.0 interface appears, displaying the image(s) 
specified in step 1 above.
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Adding Sharpener Pro 3.0 to Lightroom as an 
External Editor
If Lightroom is found during the installation of Sharpener Pro 3.0 
for Lightroom, Sharpener Pro 3.0 can automatically be added as 
an external editor. Sharpener Pro 3.0 can also be manually added 
as an external editor providing easy access to edit your photos 
in Sharpener Pro 3.0. Follow the steps below to manually add 
Sharpener Pro 3.0 as an external editor. 

1.  Open the Preferences in Lightroom.

2.  Click the External Editing tab.

3.  In the Additional External Editor section select a desired File 
Format, Color Space, Bit Depth, Resolution, and Compression.

Note: Sharpener Pro 3.0 is only compatible with TIFF files (8 or 
16-bit, with no compression or LZW compression).

4.  Click on Choose to select an application. Navigate to the 
location of Sharpener Pro 3.0.

 On Windows, the default installation location for Sharpener Pro 
3.0 will be: 

 C:\Program Files\Nik Software\Sharpener Pro 3.0 for Lightroom\

 On Macintosh, the default installation location for Sharpener 
Pro 3.0 will be: 

 Macintosh HD : Applications : Nik Software : Sharpener Pro 3.0 
for Lightroom

5. Select the Sharpener Pro 3.0 file and click Choose.

6.  Under the Preset drop-down menu, select Save Current 
Settings as New Preset… and name the preset.

Sharpener Pro 3.0 can then be easily accessed under the Photo 
menu as a preset external editor.

Accessing Sharpener Pro 3.0 in Lightroom
Once Sharpener Pro 3.0 is added to Lightroom as an external editor, 
Sharpener Pro 3.0 is accessed from the Photo menu.

To begin using Sharpener Pro 3.0 in Lightroom:

1.  Highlight the image(s) that you wish to enhance with 
Sharpener Pro 3.0. 

2. Click the Photo menu.

3. Roll over the Edit In sub-menu. A popup menu appears. 

4. Select Sharpener Pro 3.0 from the popup. 

5.  After selecting Sharpener Pro 3.0, select whether to 
Edit Original, Edit a Copy, or Edit Copy with Lightroom 
Adjustments.

Note: If Edit a Copy with Lightroom Adjustments is selected, the 
Copy File Options must be determined as well. Select the File 
Format, Color Space, Bit Depth, Resolution and Compression for 
the new file to be edited in Sharpener Pro 3.0*.

*Sharpener Pro 3.0 is only compatible with TIFF and JPEG files (8 
or 16-bit with no compression or LZW compression).

6.  Click Edit and the Sharpener Pro 3.0 interface appears, 
displaying the image(s) specified in Step 1 above.

Chapter 3: Installation
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Workflow

The order of steps involved in enhancing an image varies, depending 
on the image. In general, there are only a few guidelines to consider:

- Apply noise reduction, such as with Nik Software Dfine® 2.0, as 
early as possible in the process.

- Apply RAW Presharpening, if desired, with Nik Software 
Sharpener Pro 3.0’s RAW Presharpener filter.

- Apply light and color enhancements with Nik Software 
Viveza™ (global, then local), and end with enhancements 
using Nik Software Color Efex Pro™ 3.0 or Nik Software 
Silver Efex Pro™. 

- Apply output and creative sharpening with Nik Software 
Sharpener Pro 3.0’s Output Sharpener filter.

 © 2008 Margot Cavin

Workflow Diagram

Apply Noise Reduction 
with Dfine 2.0

Control Color and 
Light with Viveza 

Apply Enhancements 
with Color Efex Pro 3.0

Convert to black and white 
with Silver Efex Pro

OR

Apply RAW Presharpening         
with Sharpener Pro 3.0

Apply Output Sharpening         
with Sharpener Pro 3.0
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Sharpener Pro 3.0 Workflow

Start by applying RAW presharpening with the RAW Presharpener 
filter, if desired. Next, after applying light, color, and stylizing 
effects, perform device specific output sharpening and creative 
sharpening with the Output Sharpener. 

For best results in Sharpener Pro 3.0, perform the tasks below  
in the given order:

1.  Select the filter to apply to the image from the Filter menu  
or the Selective Tool.

2. Adjust the filter controls.

3.  Use U Point powered control points, to selectively apply  
or control the sharpening effect if desired.

4. Review the image in the Loupe.

5. Apply the filter.

Note: When using the RAW Presharpener, turn off any sharpening 
in the RAW processor. To achieve optimal results with the Output 
Sharpener, resizing should be done prior to performing final 
output sharpening as the size of the image will impact the amount 
of sharpening applied to the image.

5

4

3

2

Output Sharpener Interface in Adobe® Photoshop® Photograph © 2008 Tony Sweet

Chapter 4: Workflow



14

Sharpener Pro™ 3.0 User Guide

Creating Actions and Batch Processes 
(Adobe Photoshop Only)

Both the Sharpener Pro 3.0 RAW Presharpener and Output 
Sharpener filters can be applied as Actions and as part of a batch 
process within Adobe Photoshop. 

All settings other than control points that were used when the filter 
was saved in the creation of the Action will be applied when the 
Action, batch process, or Droplet is used.

To begin, create an Action with the filter that you wish to apply in the 
Action, Batch Process, or Droplet. To create an Action, follow these 
steps below:

1. Open an existing file.

2.  Open the Actions palette within Photoshop. If the actions 
palette is not visible within Photoshop, navigate to the 
Window menu and select Actions. 

3.  Click on the Create New Action button located in the bottom 
row of buttons of the Actions Palette.

4.  Name the Action according to the filter that you wish to apply 
as an Action, Batch Process, or Droplet, and click Record.

5.  Navigate to the Filters menu of Photoshop, and select  
the filter.

6.  Adjust the sliders and controls within the filter, and click OK.

7.  Stop the action by clicking on the square button located in the 
bottom row of buttons of the Actions Palette.

To start a Batch Process of a folder of images, navigate to the 
File > Automate menu and select Batch. Before beginning this 
process, it is recommended that you create a new folder on your 
desktop labeled with the action name and the word “Processed.” 
For Example: “Sharpener Pro 3.0—Output Sharpener Processed.” 
This folder will contain all of the images once the action has been 
applied to them.

To start the Batch Process, follow these steps:

1.  Ensure that the action that was created earlier is indicated 
in the Action pull-down menu. If the correct action is not 
indicated, click on the pull-down menu and select the  
correct action.

2.  Under source, indicate folder, and then click Choose. Navigate 
to the folder that contains all of the images that you want to 
apply the Batch Process to.

3.  Under Destination, select Folder. Click Choose and navigate 
to the folder that was created on your desktop earlier. 
For example, navigate to the “Sharpener Pro 3.0—Output 
Sharpener Processed” folder.

4. Click OK.

The Batch Process will now begin and apply the filter from the Action 
to all of the images in the folder, and save a new copy of the image 
with the filter applied to the folder that was created on the desktop.

Chapter 4: Workflow
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Using Sharpener Pro 3.0 as a Smart Filter 
(Adobe Photoshop Only)

When working within Adobe Photoshop CS3 and CS4, Sharpener 
Pro 3.0 can be applied as a Smart Filter. Smart Filters enable you 
to adjust the filter’s settings even after the filter interface has been 
closed. If saving the file as a PSD or layered TIFF, you can adjust the 
filter settings after the image and Photoshop have been closed, 
enabling a non-destructive workflow.

When working as a Smart Filter, the Brush button is disabled, and 
the filter will be applied to the active layer (even if the After Clicking 
OK setting is set to the Separate Layer option).

Note: Sharpener Pro 3.0 can only work as a Smart Filter feature 
with Adobe Photoshop CS3 and CS4 as the host.

Note: Perform any rotations or transforms to the image prior to 
applying Sharpener Pro 3.0 as a Smart Filter. Applying a rotation 
or transformation after applying Sharpener Pro 3.0 as a Smart 
Filter can result in a different filter effect. Also, any crops done to 
an image after converting the layer to a Smart Object will not be 
shown in the Sharpener Pro 3.0 interface, the image prior to crop 
will be displayed.

To use Sharpener Pro 3.0 as a Smart Filter:

1.  Select the layer in the Layers Palette to apply 
Sharpener Pro 3.0 to.

2. Click the Filter menu.

3. Select Convert for Smart Filters.

4. Select the Filter menu again.

5. Rollover the Nik Software submenu. A pop-up menu appears. 

6. Select one of the Sharpener Pro 3.0 filters.

Sharpener Pro 3.0 can be applied to multiple images when working 
in Lightroom and Aperture.

Chapter 4: Workflow

Note: When batch processing with Sharpener Pro 3.0, the 
sharpening effect is not applied to a separate layer. To apply 
Sharpener Pro 3.0 to a separate layer while recording the action, 
duplicate the layer prior to applying Sharpener Pro 3.0. This 
ensures that the batch process includes a new filtered layer for 
each image.

Note: When batch processing with Sharpener Pro 3.0, control 
points used in the initial filter settings will not be applied due 
to the location specific and image dependent nature of control 
points. All other filter settings will be used in the action.  
To selectively apply the filter with a batch process, use the  
Color Ranges method in the RAW Presharpener and Output 
Sharpener filters as the batch process will save the Color Ranges 
information used.
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Multiple Image Controls (Lightroom)

Sharpener Pro 3.0 can be applied to multiple images when working 
in Lightroom. To apply Sharpener Pro 3.0 to multiple images, follow 
the steps below: 

1.  Highlight the images you wish to enhance. Hold the Shift key 
to select a sequence of images or the Control/Command key 
to select individual images.

2.  Click on the Photo menu.

3.  Roll over the Edit In… sub-menu option. A popup will appear. 

4.  Select one of the Sharpener Pro 3.0 filters from the popup.

Multiple Image Controls (Aperture)

Sharpener Pro 3.0 can be applied to multiple images when working 
in Aperture. To apply Sharpener Pro 3.0 to multiple images, follow 
the steps below: 

1.  Highlight the images you wish to enhance. Hold the Shift key 
to select a sequence of images or the Command key to select 
individual images.

2. Click on the Images menu.

3. Roll over the Edit With sub-menu option. A popup will appear.

4. Select one of the Sharpener Pro 3.0 filters from the popup.

When using Sharpener Pro 3.0 with multiple images, three new 
image controls are available. The new image controls available are 
Previous, Next and Save All. Please see the Multiple Image Controls 
(Lightroom & Aperture Only) section of the Filter interface chapter for 
more information.



Chapter 5

U Point® Technology
Precise Selective Sharpening
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Sharpener Pro 3.0 is powered by U Point® image editing technology. 
U Point technology enables you to modify sections of a photograph 
directly or control where an enhancement is being applied 
selectively all without having to go through the time-consuming 
process of making a selection or mask normally required in other 
software applications.

U Point technology provides precise and direct selective control, 
providing powerful yet simple photographic manipulation. 

The U Point powered control points found within Sharpener Pro 
enable you to work with your images and selectively control and 
adjust the sharpening applied to the image without the need for 
complicated selections or masks.

Control points work by identifying an object based on a number of 
criteria. When you place your first control point, U Point technology 
identifies the unique elements of the object on which you place a 
control point, including its position, color, saturation, and texture. 
By identifying these elements, and in conjunction with the Size 
slider, the control point can determine the boundaries of the object 
in order to affect only that object and objects with like elements. 
With every control point that you apply to the image comes greater 
control over specific objects in the image. The additional control 
points ensure that the adjustments you make are being applied to 
the current object only, and placing a control point on an object  
with default settings prevents other control points from affecting 
that object.

Through a unique mixing function, the effects of the control points 
are applied throughout the image so as to create a natural-looking, 
seamless result.

For more information on U Point technology and how it works, please 
go to www.upoint.com.

http://www.upoint.com
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Sharpener Pro 3.0 offers two filters for sharpening your images: the 
RAW Presharpener and the Output Sharpener.

RAW Presharpener

RAW presharpening is the first step of a two-step sharpening process 
that some photographers have found can provide better quality in 
some images than a typical single-step sharpening process. When 
working in a two-step sharpening process, some small amount of 
sharpening is applied immediately after converting a RAW file, while 
a second, more aggressive amount of sharpening is applied directly 
before output. If you plan to utilize only a single sharpening step, 
only apply the Output Sharpener to your images.

The RAW Presharpener from Sharpener Pro 3.0 provides unique 
selective control utilizing U Point technology as well as advanced 
control over the presharpening process. When using the RAW 
Presharpener, images should be sharpened slightly to notice a  
small difference and a slightly enhanced clarity in the fine details  
of an image.

The RAW Presharpener filter should be used immediately after 
processing a RAW file and after any noise  reduction has been 
applied. When using the RAW presharpener filter, ensure that 
sharpening has been turned off in your RAW conversion tool such 
as Adobe® Camera RAW, Adobe® Photoshop®, Apple® Aperture™, 
Capture NX 2, or Canon® Digital Photo Pro.

Output Sharpener

The Sharpener Pro 3.0 Output Sharpener filter is designed to 
sharpen based on the loss of detail caused through different 
output methods, eliminating guesswork normally associated with 
sharpening for output. Covering the widest spectrum of output 
devices including display, inkjet, continuous tone, half tone, and 
hybrid tone techniques, the Output Sharpener filter provides optimal 
controls for creating perfectly sharpened images for any output. The 
highest quality sharpening and the power to selectively apply the 
sharpening with the use color ranges or of U Point® powered control 
points make the Output Sharpener filter the professional’s choice for 
sharpening their images for output.

In addition to the U Point powered control points, the Output 
Sharpener filter also offers new controls for creatively sharpening 
images to enhance fine details and textures. The creative sharpening 
techniques in Sharpener Pro 3.0’s Output Sharpener provide 
photographers with the a full toolset for creatively sharpening 
images to draw focus and attention to specific areas of your images 
while also precisely sharpening images.

The Output Sharpener filter should be used as the very last step 
in the workflow, after any cropping or resizing. Use the Output 
Sharpener filter to prepare your file for the output device of 
your choice. If applying the sharpening and then saving, it is 
recommended that you note in the file name that sharpening has 
been applied to that image.
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View 
Modes

Filter Controls

Preset Manager

Navigator Loupe

Control Points

Resize Corner

Preview Modes Select, Zoom, and Pan Tools

Output Sharpener Interface in Adobe® Photoshop® Photograph © 2008 Nadia Salameh
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View Modes

Sharpener Pro 3.0 offers three modes for viewing filter effects on 
the active image:

Single Image View

The image is displayed with the filter’s effect applied across the 
Image Preview area. To see the effect before and after, toggle 
Preview on and off with the Preview checkbox.

Split View 

The image is displayed with a 
red line running either vertically 
or horizontally through it. The 
portion to the left or above the 
red line shows the image prior 
to applying the filter; the portion 
to the right or below the red line 
shows the image after the filter 
has been applied.

You can move the image with the Pan Tool or click and drag the red 
line to observe the effect on the image’s detail.

Click the Rotate Preview button to alternate between vertical 
and horizontal split.

Chapter 7: Sharpener Pro 3.0 Interface

Side-by-side Preview 

Two separate previews 
appear. The portion on 
the left or on top shows 
the image prior to 
applying the filter; the 
portion on the right or 

at bottom shows the image after the filter has been applied.

The previews are linked for zooming and panning. This lets  
you see the before- and after-images as a whole, or at the  
fine-detail level.

Click the Rotate Preview button to alternate between  
vertical and horizontal layout.

Preview

Preview lets you toggle on and off a preview of the filter effects 
applied to the active image.

•		Click	the	Preview checkbox to alternate between displaying 
and hiding the effects
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Preview Modes

Both the RAW Presharpener and the Output Sharpener filters offer 
different modes to preview the sharpening effect on your image. 
These previews can help you determine where the sharpening has 
been applied by the selective tools as well as to preview to the final 
output sharpening result.

The RAW Presharpener and the Output Sharpener provide the 
following controls within the Modes pull-down menu:

Sharpened Image 

In this default mode, the image will be displayed with the 
sharpening effect applied.

Sharpening Soft Proof (Output Sharpener Only)

The Sharpening Soft Proof in the Sharpener Pro 3.0 Output 
Sharpener filter provides the ability to preview the final result 
on your monitor, as it will be created by your output device. This 
enables you to make decisions on the amount of sharpening to 
apply without having to print out the image. Use the Sharpening 
Soft Proof preview mode to use the Soft Proof functionality.

Utilizing the Sharpening Soft Proof will automatically resize the im-
age to resemble the image as it would be viewed when printed at a 
normal viewing distance. When the Sharpening Soft Proof is en-
abled, you can adjust the Output Sharpening, Creative Sharpening, 
and Selective Sharpening controls to fine tune the image for your 
desired sharpening level.

Effect Overlay

The original image appears with an overlay showing where the 
selective sharpening effect is applied, according to the color ranges 
or control points added to the image. You can adjust the filter 
controls or control points while in the Effect Overlay mode.

A red overlay indicates those 
areas enhanced by the filter; 
no visible overlay (i.e., the 
original colors of the image) 
indicates unaffected areas.

Effect Mask

This mode displays the mask 
created automatically by the 
color ranges and the control 
points used in the image. You 
can adjust the filter controls 
or control points while in the 
Effect Mask mode.

White indicates those areas 
enhanced by the filter, black indicates unaffected areas, and gray 
indicates moderately affected areas. 

24
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Select Tool

The Select Tool lets you select and interact with Control Points.

SELECT SHORTCUTS

Press the A key to switch to this tool.

Ctrl (Windows) / Command (Mac) to temporarily switch to this tool

Zoom Tool

The Zoom Tool lets you zoom in and out of the active image. Select 
this tool, then click on the area of the image that you want to 
magnify. To zoom out, press and hold the Alt (Windows) or Option 
(Macintosh) key and click on the image.

Sharpener Pro 3.0 offers three zoom states:

- Zoom to Fit to see the entire image within the Image Preview 
and automatically adjust the zoom factor as you change the size 
of the interface.

- 100% to show the actual pixel details.

- 300% to zoom even further into the image and view  
fine pixel detail.

ZOOM SHORTCUTS

Press the Z key to switch to this tool.

Ctrl (Windows) / Command (Macintosh)  + Spacebar to temporarily 
switch to this tool

Ctrl (Windows) / Command (Macintosh)  + ‘+’ to zoom in one level

Ctrl (Windows) / Command (Macintosh)  + ‘-’ to zoom out one level

Ctrl (Windows) / Command (Macintosh)  + 0 to Zoom to Fit

Ctrl (Windows) / Command (Macintosh)  + Alt (Windows) / Option 
(Macintosh) + 0 to zoom to 100%

Pan Tool

The Pan Tool lets you reposition the image while zoomed into the 
100% or 300% views. When the Loupe tool is enabled, the mouse 
pointer becomes a Pan Tool to let you reposition the content of  
the Loupe tool.

PAN SHORTCUTS

Press the H key to switch to this tool.

Spacebar to temporarily switch to this tool

Background Color Selector

The Background Color Selector tool lets you change the color of the 
background surrounding the image. The three choices are Light Gray, 
Medium Gray, and Dark Gray.

Chapter 7: Sharpener Pro 3.0 Interface
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Image Preview

The Image Preview area displays the active image and related 
information beneath the image.

Image

The active image is displayed with the view, preview mode, 
background and zoom state you have configured. This area has three 
zoom states: Zoom to Fit, 100%, and 300%, controlled with the 
Zoom Tool or with keyboard shortcuts. (Please see Zoom Tool above.)

Image Info

The filename appears below the image. This is visible in the Zoom 
to Fit state. The image height, width, and resolution will also be 
displayed under the filename.

Filter Controls

Sharpener Pro 3.0 has two separate filters to provide sharpening 
through the photographic workflow. The available Sharpener Pro 
3.0 filters are the RAW Presharpener and the Output Sharpener. 
The filter controls change to match the filter selected. (For a 
complete explanation, please see the RAW Presharpener and Output 
Sharpener chapters.)

Navigator Loupe

The Navigator Loupe is one of the new interface features in 
Sharpener Pro 3.0. This tool ensures that the appropriate 
information is displayed depending on the state of the Image 
Preview. In the Zoom to Fit view, the Loupe mode displays details 
under the mouse pointer at 100%, and image detail information 
before and after the filter is applied. When zoomed to 100% or 
300%, the Navigator mode is displayed, giving you a bird’s eye 
view of where you are currently in the image. The view switches 
automatically between Navigator and Loupe for efficient workflow.

Loupe Mode

With the Image Preview in the Zoom to Fit 
state, the Navigator switches to Loupe mode. 
A vertical red line bisects the image, the  
left-hand section displaying the image prior  

to applying the filter and the right-hand side, the image after  
filter application.

This ensures that you can always see the image detail at 100%  
while reviewing the filter’s effect where you position your mouse  
in the Preview.

To lock in place the area displayed in the Loupe, click the pushpin 
icon in the lower-left corner of the Loupe, then click on the area of 
the image you want to keep inside the Loupe. To unlock the area, 
click the pushpin icon again. Alternately, right-click (Windows) or 
Control-click (Macintosh) to toggle the lock in place function. 

Chapter 7: Sharpener Pro 3.0 Interface
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To pan within the Loupe display, click and drag the image. You can 
also click and drag the red line to adjust the relative size of the 
before and after sections in the Loupe.

Navigator Mode

When you switch the Zoom to Fit state to 100% 
or 300%, the Navigator Loupe switches to the 
Navigator mode and a red rectangle indicates 
the area of the image currently displayed in 

the Image Preview. Click on the area of the image in the Navigator 
that you would like to display in the Image Preview. 

Filter Controls

The Brush and OK/Save buttons process and apply the specified 
filter’s effect to the active image. The Cancel button discards any 
settings specified in the current session, and closes Sharpener Pro 
3.0, without changing the image.

Brush (Adobe Photoshop Only)

Click Brush to apply the filter’s effect to a separate layer and 
then selectively paint the effect in, using the Selective Tool to 
automatically create and modify a layer mask. (Please see Chapter 
10: Selective Tool.)

Cancel

Click Cancel to prevent any effect from being applied to the image, 
close the current Sharpener Pro 3.0 session, and return to your 
image editing application.

CANCEL SHORTCUT

Press the Esc key to cancel.

OK (Adobe Photoshop) / Save (Aperture and Lightroom)

Click OK/Save to apply the specified filter to the image(s), close 
the current Sharpener Pro 3.0 session, and return to your image 
editing application. Sharpener Pro 3.0 also gives you the option of 
applying the filter to a separate layer or to the current layer in Adobe 
Photoshop or Photoshop Elements. (Please see Chapter 11: Filter 
Interface Settings.)

OK/SAVE SHORTCUT

Press Enter (Windows) / Return (Macintosh) key to apply the filter.

Chapter 7: Sharpener Pro 3.0 Interface
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Multiple Image Controls (Lightroom & Aperture Only)

When using Sharpener Pro 3.0 with multiple images, three new 
image controls are available. The new image controls available are 
Previous, Next and Save All.

Previous

The Previous button will go to the image previously enhanced within 
the current Sharpener Pro 3.0 session.

Next

The Next button will proceed to the next selected image in the 
current Sharpener Pro 3.0 session. 

Save All

The Save All button will apply Sharpener Pro 3.0 to the open images, 
and close the current Sharpener Pro 3.0 session.

SAVE ALL SHORTCUT: 

Press the Enter (Windows) / Return (Macintosh) key to apply 
Sharpener Pro 3.0 to the selected images in the current Sharpener 
Pro 3.0 session.

Chapter 7: Sharpener Pro 3.0 Interface
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The RAW Presharpener filter is an optional step in an image editing 
workflow and is designed to be the first stage of sharpening your 
images, and should be done near the beginning of your workflow. 
Apply the RAW Presharpener immediately after any noise reduction 
has been applied. The RAW Presharpener filter adds a small amount 
of sharpening and was designed to sharpen your images for any loss 
of detail through digital capture without creating any sharpening 
artifacts or enhancing the visibility of noise. If using the RAW 
Presharpener filter, please ensure to turn off any sharpening during 
image capture and the RAW processing. 

Adaptive Strength 

The Adaptive Strength slider controls the amount of sharpening 
applied to the whole image. Decreasing this slider will reduce the 
amount of sharpening applied to the whole image while increasing 
this slider will increase the amount of sharpening applied to the 
whole image. 

Edge Balance 

The Edge Balance will control where the sharpening is applied. With 
the Edge Balance slider, adjusting the slider towards Sharpen Areas 
will sharpen those regions between the edges of objects more than 
the edges, while adjusting the slider towards Sharpen Edges will 
sharpen the edges more than the regions between the edges of 
objects. In the middle, the sharpening is applied equally between 
the areas and edges.

Image Quality 

The Image Quality control has two options for adjusting how the 
sharpening is applied.

-  Normal – An image with normal image quality will sharpen 
based on the normal information presented in an image. 

-  High ISO – The High ISO image setting will work to prevent  
any noise left in the image from being enhanced by the 
sharpening process

Selective Sharpening
The Selective Sharpening section 
of the RAW Presharpener filter 
controls the selective sharpening 
applied to the image. The 
Selective Sharpening section can 
be toggled on and off with the 
preview checkbox to help show 
the effect of just the Selective 
Sharpening techniques applied  
to the image.

The RAW Presharpener filter has two methods for selectively 
applying the sharpening to the image: Control Points and  
Color Ranges.

Control Points

The first method of selectively 
applying the sharpening in 
the Sharpener Pro 3.0 RAW 
Presharpener filter, Control 
Points, is based on U Point® technology.

Chapter 8: RAW Presharpener Filter Controls

S

LC

F

Selection Control Point



31

Sharpener Pro™ 3.0 User Guide

U Point technology lets photographers identify and isolate objects 
within a photograph by placing a control point on the object or area 
to be affected. By analyzing color, tonality, detail and location, 
U Point determines where to apply certain effects, according to the 
photographer’s needs. (For more information on U Point technology, 
please visit www.upoint.com.)

All control points within the active image communicate with 
each other, providing continuity of control over multiple objects 
throughout the image.

When collapsed, this section provides access to the Add 0% Control 
Point and Add 100% Control Point buttons, enabling you to use 
U Point powered control points to specify where an image’s effect is 
applied within the image, without using masks and selections.

When expanded, this section provides you with a list of the  
control points added to the image, as well as controls for those 
control points.

Each control point in the RAW Presharpener filter can control the 
extent to which the selected object is affected by a filter. This lets 
you add control points and then decide the amount of sharpening to 
apply to each object.

Each control point has two sliders:

- The top slider, Size, controls the size or reach of the control 
point. Increase this control to enlarge the control point’s reach, 
or decrease to reduce its reach, as indicated by an expanding or 
contracting circle

- The bottom slider, Opacity, controls the extent to which the 
effect is added to the image. At 100%, the filter’s full effect 
is applied to the selected object; at 0%, the selected object 
retains its original colors and details.

Add 0% Control Point

Click this button to add a control point preset to no filter effect (i.e., 
0% opacity). The mouse pointer changes, indicating that you can 
place a control point on the image. After placing the control point on 
the image, you can adjust the Opacity slider.

Add 100% Control Point

Click this button to add a control point preset to the full effect of  
the filter (i.e., 100% opacity). The mouse pointer changes, indicating 
that you can place a control point on the image. After placing the 
control point on the image, you may adjust the filter’s effect with  
the Opacity slider.

If the first control point added is a 100% Control Point, the Apply to 
entire image slider will automatically move to 0% to ensure that the 
filter effect is applied only at that control point. You can then adjust 
the slider manually.

Apply to entire image

This slider lets you specify 
how much of the current effect to apply across the entire image. 

Any control points added to the image override the effect of this 
slider for the object they select. For example, if you specify a filter 
effect on an entire landscape photograph, set Apply to entire image 
to 100%, and then later add a control point to the sky at 0% opacity, 
the filter will have no effect on the sky.

Chapter 8: RAW Presharpener Filter Controls
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Control Point Details

This area shows you the details 
for each of the control points 
currently added to the image. 

Click on a control point listed in this section to select it in the  
image, and click on the percentage displayed to type in a new  
value manually.

Duplicate

To create a duplicate copy of a control point, click the Select tool, 
and then click on the control point to be duplicated. Next, click on 
the Duplicate button. An exact copy of the selected control point will 
be placed on the image and you can then reposition the new control 
point by clicking and dragging it to a new location.

DUPLICATE SHORTCUTS: 

Ctrl (Windows) / Command (Macintosh) + D to duplicate in place

Alt (Windows) / Option (Macintosh) + Left-click to duplicate and 
move a control point

Delete

Click the Delete button to remove the selected control points 
from the image and set the Apply to entire image slider to 100%. 
Alternatively, select a control point and then click the Delete key on 
the keyboard to remove the selected control point.

To adjust or delete multiple control points or adjust their controls 
in parallel, first select the desired control points by one of the 
following methods:

- Click the Select Tool, then left-click, hold and draw a bounding 
box containing the desired control points, or

- Hold the Shift key down and click on the control points to  
be selected.

With multiple control points selected, you can delete all or modify 
the filter controls of all control points at the same time by adjusting 
those of only one.

After adding control points to the image and applying different 
levels of opacity to each object, you can look at the Effect Overlay or 
Effect Mask to see how the filter is affecting the image. (Please see 
Effect Overlay and Effect Mask below.)

Note: Control points are not saved in a settings file and therefore 
cannot be applied in a batch process.

Color Ranges

The second method of selectively 
sharpening within the Sharpener 
Pro 3.0 RAW Presharpener filter is 
based on individual Color Ranges.

This method is most effective when 
affecting large objects or if you 
want to uniformly sharpen based 
on color. Additionally, this is the 
recommended method to use if you 
would like to selectively sharpen 
noise in a batch process.

Chapter 8: RAW Presharpener Filter Controls
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You can have as few as two color ranges selected, with no maximum 
to the number possible.

Color Patch

The Color Patch will display the color considered for sharpening for 
the current color range. Hold the mouse over the patch to see a read-
out of the RGB color values for the color selected.

Click on the Color Patch to call up the Color Picker from your image 
editing application to set a color directly. 

Eyedropper

The Eyedropper will let you select a color from the image displayed 
within the Sharpener Pro 3.0 RAW Presharpener interface. After 
selecting this color, you can then determine how much sharpening 
to apply against any objects that are based on that color.

Opacity

The Opacity slider controls the amount of sharpening applied to the 
selected Color Range. Decreasing this slider will reduce the amount 
of sharpening applied while increasing this slider will increase the 
amount of sharpening applied. 

Change the amount of the Opacity slider to balance sharpening 
detail and enhancing noise, the higher the value of the Opacity 
slider, the more sharpening will be applied to the selected color 
range in the image.

Chapter 8: RAW Presharpener Filter Controls

Add Color Range

Click on this button to add an additional color range to the image.

Delete Color Range

Click on this button to delete a color range. The Delete Color Range 
buttons will disappear if you reach only two color ranges, which is 
the minimum. As soon as you click on the Add Color Range button, 
the Delete Color Range buttons will appear again for all color ranges.
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The Sharpener Pro 3.0 Output Sharpener is the last step in the 
photographic workflow and sharpens images based on the specific 
device that will be used to output the image, eliminating the 
guesswork generally associated with sharpening and providing the 
precise amount of sharpening needed to retain detail without over-
sharpening the image. 

Output Sharpening Preset Manager

The Output Sharpening 
Preset Manager provides 
photographers with the 
ability to create and save presets for quick and easy applications of 
output sharpening. Saving a preset in the Output Sharpener filter 
will retain all sharpening information set in the Output Sharpening 
and in the Creative Sharpening; controls within the Selective 
Sharpening section will not be retained. 

To create an Output Sharpening Preset, set the Output Sharpening 
controls, then apply any global creative sharpening with the Creative 
Sharpening controls, and finally click Add New Preset in the Output 
Sharpening Preset Manager. 

Other controls available in the Output Sharpening Preset Manager 
are the ability to update presets and delete presets. Roll over a 
preset to display either the update or delete buttons. Click on the 
Update button to update the preset with the current settings.  
Click on the Delete button to remove the preset from the list of 
available presets.

Output Sharpening 

The Output Sharpening provides a list of the output device options 
that the Output Sharpener filter can sharpen for. The output device 
options are:

- Display – Sharpens for display devices such as monitors  
and projectors.

- Continuous Tone – Sharpens for continuous tone printers such 
as prints found at photographic labs using silver-halide based 
papers and dye-sublimation printers.

- Halftone – Sharpens for halftone printers such as large web- or 
sheet-fed presses.

- Inkjet – Sharpens for inkjet printers such as Canon, Epson, 
and HP.

- Variable Tone – Sharpens for printers that use a hybrid of inkjet 
and halftone screening techniques. 

Display Sharpening Controls

When Display is the device chosen from the Output Sharpening 
menu, use the Adaptive Sharpening slider to control the amount of 
sharpening applied to the entire image.

Then use the Output Sharpening Strength in the Creative 
Sharpening controls section to control the opacity of the sharpening 
applied to the entire image.
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Continuous Tone  
Sharpening Controls

When Continuous Tone is the device 
chosen from the Output Sharpening 
menu, the following controls are 
available:

- Viewing Distance – The Viewing Distance pull-down menu 
will factor into how much sharpening is applied to the current 
image. The Auto setting will automatically determine the 
viewing distance based on the diagonal of the image’s height 
and width, which is commonly accepted as the normal viewing 
distance for a photograph. 
 
The Auto setting is recommended, but if the image is not going 
to be viewed at the normal viewing distance for that size  
image options are provided to sharpen based on a preset 
viewing distance.

- Printer Resolution – The Printer Resolution selects the 
resolution that the printer will print at. Use the Printer 
Resolution pull-down menu to select the appropriate resolution. 
Please contact your lab or printer’s user manual for the 
appropriate resolution to select. 
 
If the appropriate resolution is not found within the pull-down 
menu, please select one of the User Defined options and then 
enter the appropriate resolution in the box provided.

Halftone Sharpening Controls

When Halftone is the device chosen 
from the Output Sharpening menu, 
the following controls are available:

- Viewing Distance – The 
Viewing Distance pull-down 
menu will factor into how much sharpening is applied to the 
current image. The Auto setting will automatically determine the 
viewing distance based on the diagonal of the image’s height 
and width, which is commonly accepted as the normal viewing 
distance for a photograph. 
 
The Auto setting is recommended, but if the image is not going 
to be viewed at the normal viewing distance for that size  
image, options are provided to sharpen based on a preset 
viewing distance.

- Paper Type – The Paper Type pull-down menu selects what type 
of paper medium the image will be printed on. The options  
are Newsprint, Uncoated, Coated, and High Gloss, with 
Newsprint applying the most sharpening and High Gloss 
applying the least.

- Printer Resolution – The Printer Resolution selects the 
resolution that the print will be created at. For Halftone presses, 
the resolution is measured in Lines per Inch and Lines per 
Centimeter (lpi or lpcm). Please contact your pre-press contact 
for information on the appropriate resolution to select.
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Inkjet Sharpening Controls

When Inkjet is the device chosen 
from the Output Sharpening menu, 
the following controls are available:

- Viewing Distance – The 
Viewing Distance pull-down menu will factor into how much 
sharpening is applied to the current image. The Auto setting 
will automatically determine the viewing distance based on the 
diagonal of the image’s height and width, which is commonly 
accepted as the normal viewing distance for a photograph. 
 
The Auto setting is recommended, but if the image is not going 
to be viewed at the normal viewing distance for that size  
image, options are provided to sharpen based on a preset 
viewing distance

- Paper Type – The Paper Type pull-down menu selects what type 
of paper medium the image will be printed on. The options are 
Textured & Fine Art, Canvas, Plain Paper, Matte, Luster, and 
Glossy, with Textured & Fine Art applying the most sharpening 
and Glossy applying the least.

- Printer Resolution – The Printer Resolution selects the 
resolution that the print will be printed at. Choose from the 
drop down menu the resolution that the printer will be printing 
at. Please refer to your printer’s manual to determine the 
appropriate resolution to select. 
 
If the appropriate resolution is not found within the pull-down 
menu, please select one of the User Defined options and then 
enter the appropriate resolution in the two boxes provided. 

Hybrid Device  
Sharpening Controls

When Hybrid Device is the device 
chosen from the Output Sharpening menu, the following controls  
are available:

- Viewing Distance – The Viewing Distance pull-down menu 
will factor into how much sharpening is applied to the current 
image. The Auto setting will automatically determine the 
viewing distance based on the diagonal of the image’s height 
and width, which is commonly accepted as the normal viewing 
distance for a photograph.  
 
The Auto setting is recommended, but if the image is not going 
to be viewed at the normal viewing distance for that size  
image, options are provided to sharpen based on a preset 
viewing distance

Creative Sharpening

The Creative Sharpening 
controls can be used to control 
both the strength of the output 
specific sharpening and apply 
any global creative sharpening 
to the image. Control points 
can later be used to selectively 
adjust the amounts of each of 
these controls on any object or 
area within the image.
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- Output Sharpening Strength — The Output Sharpening Strength 
slider is the main global sharpening control in the Output 
Sharpener filter, which controls the strength of the output 
sharpening applied to the overall image. Increasing the Output 
Sharpening Strength slider will increase the sharpening applied 
to the image and decreasing the Output Sharpening Strength 
slider will decrease the overall strength of the sharpening 
applied to the image.

- Structure — Controls the fine details and textures within the 
image. Increasing this slider emphasizes fine details throughout 
the image while decreasing this slider reduces the appearance 
of fine details for smoother surfaces.

- Local Contrast — Controls local contrast throughout the entire 
image. Increasing this slider will increase the edges of small 
objects throughout the image while decreasing this slider will 
lower the contrast of edges, applying a diffusing effect. 

- Focus — Controls the adaptive sharpening of fine image details 
and large areas of the image. Increasing this slider will increase 
the overall strength of the adaptive sharpening and decreasing 
this slider will decrease the adaptive sharpening, applying a 
slight blurring effect to the image.

Selective Sharpening 

The Selective Sharpening section of the Output Sharpener filter 
controls the selective sharpening applied to the image. The 
Selective Sharpening section can be toggled on and off with the 
preview checkbox to help show the effect of just the Selective 
Sharpening techniques applied to the image.

The Output Sharpener filter has two methods for selectively applying 
the sharpening to the image, Control Points and Color Ranges.

Control Points

The first method of selectively 
applying the sharpening in 
the Sharpener Pro 3.0 Output 
Sharpener, Control Points, is 
based on U Point® technology.

U Point technology lets 
photographers identify and 
isolate objects within a photograph by placing a control point on 
the object or area to be affected. By analyzing color, tonality, detail 
and location, U Point determines where to apply certain effects, 
according to the photographer’s needs. (For more information on U 
Point technology, please visit www.upoint.com.)

All control points within the active image communicate with 
each other, providing continuity of control over multiple objects 
throughout the image. When collapsed, this section provides 
access to the Add Control Point button, enabling you to use U Point 
powered control points to specify where the sharpening is applied 
within the image and the strength of the sharpening applied within 
the image, without using masks and selections.

When expanded, this section provides you with a list of the  
control points added to the image, as well as controls for those 
control points.

Each control point in the Output Sharpener can control the extent to 
which the selected object is affected by the output sharpening and 
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which creative sharpening techniques are applied to the selected 
object. This lets you add control points and then decide which 
objects to apply sharpening to as well as to control the amount of 
sharpening on each object independently

Each control point has  
five sliders:

- The top slider, Size, controls 
the size or reach of the 
control point. Increase this 
control to enlarge the control 
point’s reach, or decrease 
to reduce its reach, as 
indicated by an expanding or 
contracting circle.

- The second slider, Output Sharpening Strength, controls the 
amount of overall output device specific sharpening applied to 
the selected object or area.

- The Output Sharpening Strength/All triangle will toggle the 
available sliders on the control point between the Output 
Sharpening Strength slider and all of the sliders available. 

- The third slider, Structure, controls the amount of structure 
applied to the selected object or area. 

- The fourth slider, Local Contrast, controls the amount of local 
contrast applied to the edges of the selected object or area. 

- The fifth slider, Focus, controls the amount of adaptive 
sharpening applied to the selected object or area.

Add Control Point 

Click this button to add a control point to 
selectively control the sharpening applied to an object or area. The 
mouse pointer changes, indicating that you can place a control point 
on the image. After placing the control point on the image, you can 
adjust the sharpening controls.

By default, control points added to the image will have all sliders  
set to their default values. The default values will override the  
global Creative Sharpening controls and apply only the default 
Output Sharpening Strength to the object or area selected by the 
control point. 

To place a control point with the same slider settings as found in 
the Creative Sharpening section, change the Default Control Point 
Settings option within the Setting to Retain Creative Sharpening 
Settings. Any control point added to the image will then apply the 
global Creative Sharpening values as the default control point 
values, providing a useful starting point for the selected object 
which can then be fine tuned using the control point’s sliders.

Control Point List 

The control point 
List shows all of the 
control points applied 
to the image. The control point List section provides you with basic 
information about each control point, and options to show the 
selections and previews of the control points. 

  Show Effect Preview Column 
After adding a control point to the image, the checkbox within 
the Show Effect Preview Column will be enabled. By un-checking 
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this box, you can disable that control point’s effect on  
the image.

  Size Column 
The Size column will display the value of each control point’s 
Size slider.

  Show Selection Column 
The Show Selection Column enables you to show the selection 
of a control point. Checking the box next to a control point in the 
Show Selection Column will show only selected control points’ 
selections. Areas inked in white are being affected by the 
control point, while areas inked in black are not being affected, 
with grey areas being partially affected. Click on the Show 
Selection Column header to show or hide the selection for all of 
the control points.

  Reset Control Point Column 
The Reset control point Column enables you to reset the sliders 
back to the default settings for any individual Control Point. 

Duplicate

To create a duplicate copy of a control point, click the Select tool, 
and then click on the control point to be duplicated. Next, click on 
the Duplicate button. An exact copy of the selected control point will 
be placed on the image and you can then reposition the new control 
point by clicking and dragging it to a new location.

DUPLICATE SHORTCUTS: 

Ctrl (Windows) / Command (Macintosh) + D to duplicate in place

Alt (Windows) / Option (Macintosh) + Left-click to duplicate and 
move a control point

Delete

To remove a control point, click the Select tool, then click on the 
control point to be removed. Then either click the Delete button or 
press the Delete key on your keyboard.

With multiple control points 
selected, you can delete all or 
modify the filter controls of all 
control points at the same time 
by adjusting those of only one.

To adjust or delete multiple 
control points or adjust their 
controls in parallel, first select 
the desired control points by 
one of the following methods:

- Click the Select Tool, then 
left-click, hold and draw a 
bounding box containing 
the desired control points, 
or

- Hold the Shift key down and click on the control points  
to be selected.

After adding control points to the image and applying different 
levels of sharpening to each object, you can look at the Effect 
Overlay or Effect Mask to see how the filter is applied the image. 
(Please see Effect Overlay and Effect Mask.)
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Color Ranges

The second method of sharpener within the Sharpener Pro 3.0 
Output Sharpening is based on individual Color Ranges.

This method is most effective when affecting large objects or if you 
want to uniformly sharpen based on color. Additionally, this is the 
recommended method to use if you would like to selectively sharpen 
noise in a batch process.

You can have as few as two color ranges selected, with no maximum 
to the number possible.

Color Patch

The Color Patch will display the color considered for sharpening for 
the current color range. Hold the mouse over the patch to see a read-
out of the RGB color values for the color selected.

Click on the Color Patch to call up the Color Picker from your image 
editing application to set a color directly. 

Eyedropper

The Eyedropper will let you select a color from the image displayed 
within the Sharpener Pro 3.0 Output Sharpener interface. After 
selecting this color, you can then determine how much sharpening 
to apply against any objects that are based on that color.

Output Sharpening Strength

The Output Sharpening Strength slider controls the amount of 
Output Sharpening applied to the selected color range. Decreasing 
this slider will reduce the amount of sharpening applied to the 

selected color range while increasing this slider will increase the 
amount of sharpening applied to the selected color range. 

Change the amount of the Output Sharpening Strength slider to 
balance sharpening detail and enhancing noise, the higher the  
value of the Strength slider, the more sharpening will be applied  
to the image.

Add Color Range

Click on this button to add an additional color range to the image.

Delete Color Range

Click on this button to delete a color range. The Delete Color Range 
buttons will disappear if you reach only two color ranges, which is 
the minimum. As soon as you click on the Add Color Range button, 
the Delete Color Range buttons will appear again for all color ranges.

Chapter 9: Output Sharpener Filter Controls
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Selective Tool 

The Selective Tool automates the 
creation of layers and layer masks within 
Adobe Photoshop and Adobe Photoshop 
Elements, letting you apply any 
available Sharpener Pro 3.0 filters. 

If Dfine® 2.0, Viveza™, Color Efex Pro 
3.0™ or Silver Efex Pro™ is already 
installed, the Selective Tool installed by 
Sharpener Pro 3.0 will simply update 
the one installed previously, letting you 
access any Nik Software product from 
the same palette.

The Selective Tool can be used with 
pressure-sensitive tablets such as 
the Wacom® Pen Tablet to apply the 
Sharpener Pro 3.0 filter with pressure-
sensitivity.

Note: The Selective Tool is available only with Adobe Photoshop and 
Adobe Photoshop Elements serving as host for Sharpener Pro 3.0.

Note: The Selective Tool cannot be used when creating a Photoshop 
Action. In order to create a Photoshop Action, please select 
Sharpener Pro 3.0 from the Filters menu.
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Interaction with Sharpener Pro 3.0

Click the filter name in the Sharpener Pro 3.0 section of the Selective 
Tool window to launch that filter. 

If you click the Brush button in the Sharpener Pro 3.0 filter interface, 
whether you launched that filter from the Selective Tool or from 
Photoshop or Photoshop Elements’ Filters menu, the Selective 
Tool appears. The filter will be applied to a copy of the image on a 
separate layer, the new layer will be named after the filter you are 
using, and you can selectively apply the filter’s effect using the 
Paint, Erase, Fill, and Clear buttons described later in this chapter.

The Selective Tool contains four tools for applying the selected 
Sharpener Pro 3.0 filter.

Paint

Click the Paint button to selectively paint the current filter’s effect 
into the active image. Ensure that your Paint Brush mode is set to 
Normal and that Opacity is set to 100%. You can control the degree 
to which the effect is added to the image by varying the opacity of 
the brush.

Erase

Click the Erase button to selectively remove the current filter’s effect 
from the active image. Ensure that your Paint Brush mode is set to 
Normal and that Opacity is set to 100%. You can control the degree 
to which the effect is removed from the image by varying the opacity 
of the brush.
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Fill

Click the Fill button to apply the filter’s effect to the entire image. 
This tool is especially useful if you want to apply the filter’s effect to 
all but a small area. Click Fill, then click Erase to remove the effect 
from the area to remain unaffected.

Clear

Click the Clear button to remove the filter’s effect from the entire 
image. This is helpful if you made a mistake with the Paint tool and 
want to start over.

Apply / Discard

Click Apply to apply the current filter’s effect to the image. Click 
Discard to prevent the effect from being applied.
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Filter Interface Settings
Click on Settings in the Sharpener Pro 3.0 Filter Interface to 
configure default look and functionality, and to specify how 
Sharpener Pro 3.0 affects images. You are presented with two tabs, 
Filter Settings, and Output Sharpener Settings.

The following settings are available within the Filter Settings tab 
which will affect both the RAW Presharpener as well as the  
Output Sharpener:

Default Zoom

Default Zoom lets you specify the zoom state to be applied when the 
interface is launched. (Please see Zoom Tool.)

100%

Opens images at 100% zoom.

Zoom to Fit

Ensures that the entire image is visible within the filter interface.
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Use Last Setting

Opens images in the last zoom state used in the previous 
Sharpener Pro 3.0 session.

Default Preview

Default Preview lets you specify how images are displayed upon 
opening Sharpener Pro 3.0. (Please see Preview Modes in Chapter 7.) 

Single Image View

Sets Single Image View as default.

Split View

Sets Split view as default.

Side-by-side View

Sets Side-by-side view as default.

Use Last Setting

Opens images in the last preview state used in the previous 
Sharpener Pro 3.0 session.

Default Appearance

Default Appearance sets the brightness of the area surrounding the 
image in the Preview.

•	Light	Gray

•	Medium	Gray

•	Dark	Gray
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After Clicking OK (Adobe Photoshop Only)

This option lets you specify how Sharpener Pro 3.0 filters  
are applied.

Note: This option is valid only with Adobe Photoshop and Adobe 
Photoshop Elements serving as host for Sharpener Pro 3.0.

Apply the Filtered Effect to the Current Layer

This option applies the effect to the layer that was active when 
Sharpener Pro 3.0 was launched.

Apply the Filtered Effect to a Separate Layer

Choose this option to always apply the filter effects of Sharpener Pro 
3.0 to a separate layer. Use this option and save the final image in a 
layered format to ensure the preservation of original image details. 

Note: Enabling this option increases file size and may increase 
processing time.

Note: When batch processing with Sharpener Pro 3.0, the filter 
effect is not applied to a separate layer. To apply Sharpener Pro 
3.0 to a separate layer while recording the action, duplicate the 
layer prior to applying Sharpener Pro 3.0. This ensures that the 
batch process includes a new filtered layer for each image.

Reset

Click Reset to restore Sharpener Pro 3.0 filter settings to their 
default values.

The following settings are available within the Output Sharpener 
Settings tab:

Default Control Point Settings

Default Control Point Settings will determine if new control points 
added to the image have neutral settings or use the settings created 
with the global Creative Sharpening settings. 

Neutral Control Point

New control points will have neutral default settings when first 
added to an image.

Retain Creative Sharpening settings

New control points will use the Creative Sharpening slider values for 
defaults when first added to an image.
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Default Control Point Sliders

Default Control Point Sliders will determine what sliders  
are presented by default on control points in the Output  
Sharpening filter. 

Output Sharpening Strength

The Output Sharpen Strength option will display only the  
Output Sharpening Strength slider.

All

The All option will display all available sliders on a control  
point in the filter.

Use Last Setting

New control points will use the slider set from the last control  
point added to the image.

Default Measurement Unit

Default Measurement Unit sets the default units of measurement.

- Imperial (Inches & Feet)

- Metric (Centimeters & Meters)

Number of Inks Used

This option will set the number of inks in an inkjet printer and 
sharpen based on that information.

- Normal (4 inks)

- Photo (6 inks or more)

- Quadtone (grayscale inks)

Image Size Sliders

The Image Size Sliders option controls whether the Image Height 
and Image Width sliders are displayed within the Output Sharpening 
section. By default, these sliders are not displayed, however they 
can be enabled to support workflows in which resizing an image 
prior to sharpening is not possible.

Do not display 

The Image Height and Image Width sliders will not be displayed 
within the Output Sharpening section. This option is recommended 
as images should be resized prior to sharpening.

Display

The Image Height and Image Width sliders will be displayed within 
the Output Sharpening section. This option is recommended only in 
situations in which the image cannot be resized prior to sharpening.

Note: Changing the image size with the Image Height and Image 
Width sliders does not change the actual image size. These options 
adjust the sharpening result to appropriately sharpen images that 
will be resized by a later process.

Reset

Click Reset to restore Sharpener Pro 3.0 filter settings to their 
default values.
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Selective Tool Settings (Adobe Photoshop Only)

Click the Settings button at the bottom of the Selective Tool 
interface to specify how the Selective Tool interacts with Adobe 
Photoshop or Adobe Photoshop Elements and active images.

Selective 
Tool 
Settings

When Photoshop Launches

This option lets you specify whether the Selective Tool opens when 
Adobe Photoshop or Adobe Photoshop elements is launched. 
Choose between:

•	Automatically	Open	the	Selective	Tool

•	Do	Not	Open	the	Selective	Tool

Apply filter to:

Advanced users can specify how the Selective Tool applies filters in 
Sharpener Pro 3.0.
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Image Composite

Select this option to create a new layer and perform a stamp-visible 
command into the new layer to ensure that the filter is applied to 
the entire image and not only to the active layer. (This is the default 
behavior in Sharpener Pro 3.0. This is also how the Selective Tool 
operates in all other Nik Software products.)

Active Layer

Select this option to duplicate the layer active when you selected 
the Sharpener Pro 3.0 filter, and apply the filter to that layer only.

After clicking Apply

This option lets you specify whether the Selective Tool maintains 
Sharpener Pro 3.0 filter effects as a separate layer or merges layers 
when you click Apply.

Merge the Filtered Effect to the Current Layer

This option merges the filtered image with your original image into 
one layer. Enabling this option helps keep file sizes to a minimum.

Apply the Filtered Effect to a Separate Layer

The Keep as Layer option ensures that the filtered effect is limited 
to a separate layer. By enabling this setting and saving the active 
image in a layered file, you preserve original image information 
and can remove the filter’s effect at any time. Please keep in mind, 
however, that enabling this option may increase file sizes.
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United States

Contact Nik Software, Inc. by phone at (619) 725-3150

Monday - Friday from 8:30 AM - 5:00 PM (PST) or via email at 
service@niksoftware.com

Nik Software, Inc. 
7588 Metropolitan Drive 
San Diego, CA 92108, USA 
Phone (619) 725-3150 
Fax (619) 725-3151 
infous@niksoftware.com

www.niksoftware.com

Germany

In Europe, contact Nik Software, GmbH at +49-40-47-11-35-0

Monday - Friday from 9:00 AM - 5:00 PM (CET) or via email at 
serviceeu@niksoftware.com.

Nik Software, GmbH 
Hammerbrookstraße 93 
D-20097  Hamburg, Germany

Phone +49-40-47-11-35-0 
Fax +49-40-47-11-35-35

infoeu@niksoftware.com

www.niksoftware.com
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For more information on Nik Software products go to 

www.niksoftware.com or www.upoint.com.

© 2008 Nik Software, Inc.

Protected by one or more US Pats. 6,728,421; 6,865,300; 
7,031,547; and other patents pending.

Nik, U Point, and Dfine are registered trademarks of Nik Software, 
Inc. Viveza, Color Efex Pro, Silver Efex Pro, and Sharpener Pro are 
trademarks of Nik Software, Inc. All other trade names mentioned 
in this manual are trademarks or registered trademarks of their 
respective holders.
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